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What's New

1 What's New

New features in ODBC Driver for Firebird 3.6

¢ Fixed connection timeout setting before opening connection

e Added support for Firebird 5

¢ Now passwords are stored in an encrypted form in the DSN record
e Added Read Only mode for connection

¢ Improved compatibility with ETL Informatica PowerCenter

¢ Improved compatibility with Altova Mapforce

¢ Improved compatibility with FileMaker Server for Linux and macOS

New features in ODBC Driver for Firebird 3.5

¢ Added support for setting SQL Dialect
¢ Improved compatibility with SSIS in Visual Studio

¢ Improved compatibility with 4D in macOS

New features in ODBC Driver for Firebird 3.4

e Added support for SQL_ATTR_MAX ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio

New features in ODBC Driver for Firebird 3.3

¢ Added support for macOS 13 Ventura
¢ Improved compatibility with Tableau Prep Builder
¢ Improved compatibility with Crystal Reports

e Reduced number of metadata calls

New features in ODBC Driver for Firebird 3.2

e Added support for Windows 11
e Added support for Firebird 4
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Improved compatibility with FICO Mosel

Improved compatibility with FileMaker

Improved compatibility with JMP on macOS

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Firebird 3.1

e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for Firebird 3.0

e Compatibility with macOS Big Sur is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Minor performance improvements

e Compatibility with Power Pivot is improved

e Compatibility with Visual Basic is improve

e Compatibility with RStudio is improved

Support for connection pooling is improved

Improved compatibility with sandboxed applications for macOS

Now ODBC driver activation does not require administrator privileges

Now ODBC driver for macOS is distributed as a PKG package

Now ODBC driver for Linux is distributed as DEB and RPM packages

Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for Firebird 2.4

e Possibility to return String Types as Ansi or Unicode is added
e Compatibility with MS Access is improved

e Compatibility with Omnis Studio is improved

e Compatibility with Power Pivot is improved

e Compatibility with DBeaver is improved
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New features in ODBC Driver for Firebird 2.3

e Performance of batch operations is significantly improved

New features in ODBC Driver for Firebird 2.2

e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved

e OUTER JOIN macros in SQL queries are supported
e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

¢ The ForceUsingDefaultPort connection parameter is added

New features in ODBC Driver for Firebird 2.1

e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved

e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved

e Compatibility with Qlik is improved

e Compatibility with Delphi & C++Builder is improved

e MS Access linked tables support is improved

New features in ODBC Driver for Firebird 2.0

e Linux is supported

e macOS is supported

e Support for stored procedures and functions is improved

e Backward compatibility of SQLExecDirect with ODBC 2.x is improved
e Compatibility with MS Excel is improved

e Compatibility with ODBC 2.x is improved

e Bug with Trial expiration in Microsoft SQL Server Management Studio is fixed
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New features in ODBC Driver for Firebird 1.2

e Compatibility with Microsoft Visual Studio is improved

e Compatibility with Microsoft Office is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Compatibility with Crystal Reports is improved

e Compatibility with ClikView is improved

e Compatibility with Microsoft Power Bl Desktop is improved

e Compatibility with Microsoft Visual FoxPro is improved

New features in ODBC Driver for Firebird 1.1

e Performance is improved

New features in ODBC Driver for Firebird 1.0

¢ First release of ODBC Diriver for Firebird
e Windows 32-bit is supported
e Windows 64-bit is supported
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21 Overview

Overview

Devart ODBC Diriver for Firebird is a high-performance connectivity solution with enterprise-
level features for accessing Firebird databases from ODBC-compliant reporting, analytics, Bl,
and ETL tools on both 32-bit and 64-bit Windows, macOS, and Linux. Our ODBC driver fully
supports standard ODBC API functions and data types and enables easy and secure access
to live Firebird data from anywhere.

v ODBC API

ODBC Data -

Types
Compatibility
ODBC Driver for Firebird supports Firebird 4.x, 3.x, 2., and 1.x versions.
© 2015-2024
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2.2 Features

v ODBC API
ODBC Data -
Types

ODBC Conformance

Our ODBC driver provides full support for common ODBC interface:
e ODBC Data Types support

e ODBC API Functions support

In addition, we provide support for Advanced Connection String parameters. Thus allowing
any desktop and web applications to connect to Firebird from various environments and
platforms, that support ODBC.

64

bit

32

bit

Development Platforms Variety

ODBC Driver for Firebird doesn't limit your choice of the development platform and
environment. The driver installations are available for various operational systems and
platforms. The current version supports Windows, macOS, Linux, both 32-bit and 64-bit. So
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you can develop both 32-bit and 64-bit cross-platform applications.

]
] I

—

Database Compatibility

ODBC Driver for Firebird supports Firebird 4.x/3.x/2.x/1.x versions

=l

High Performance

All our products are designed to help you write high-performance, lightweight data access

layers, therefore they use advanced data access algorithms and techniques of optimization.

| v

Support

Visit our Support page to get instant help from knowledgeable and experienced professionals,
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2.3

a quick resolution of your problems, and nightly builds with hotfixes.

© 2015-2024
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Compatibility

Firebird Compatibility

ODBC Driver for Firebird supports the following database servers:

Firebird Servers Support
Firebird 4.x v
Firebird 3.x v"'
Firebird 2.x v
Firebird 1.x v

Note: Firebird 1.5 requires a UDF containing the RTRIM function for proper operation.

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)
e macOS 32-bit and 64-bit
e Linux, 32-bit and 64-bit

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion vy
Embarcadero Delphi & C++Builder W,
FileMaker v
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Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio
Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

CIC IS L [C KK

Python

Database Management

Aqua Data Studio

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CICO LSS

SQL Server Reporting Services

Bl & Analytics Software

<

Alteryx

DBxtra

<

Dundas Bl v
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IBM SPSS Statistics
MicroStrategy
Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports
SAS JMP

Tableau

TARGIT

A AN A YA A YA AN N

TIBCO Spotfire

Office Software Suites

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

CIS SIS S

StarOffice
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Requirements

The following requirements must be met for ODBC Driver for Firebird:

e The Firebird client library is available on your system.
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¢ Only one version of ODBC Driver for Firebird is installed on your system.

© 2015-2024
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2.5 Licensing

ODBC Diriver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;
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- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:

- make any number of copies of the Software to deploy it to your end-user.
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- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

© 2024 Enter your company name
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5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fithess for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT
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The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.
© 2015-2024
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26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Firebird
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Firebird:

¢ You can find out more about ODBC Driver for Firebird installation or licensing by consulting

Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for Firebird developers

through the ODBC Driver for Firebird Priority Support program.

Subscriptions

The ODBC Diriver for Firebird Subscription program is an annual maintenance and support

service for ODBC Driver for Firebird users.

Users with a valid ODBC Driver for Firebird Subscription get the following benefits:
e Product support through the ODBC Driver for Firebird Priority Support program
e Access to new versions of ODBC Driver for Firebird when they are released

¢ Access to all ODBC Diriver for Firebird updates and bug fixes
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¢ Notifications about new product versions

Priority Support

ODBC Driver for Firebird Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Firebird-related questions from the
ODBC Driver for Firebird developers themselves. Priority Support is carried out over email
and has a two business day response policy. Priority Support is available for users with an
active ODBC Driver for Firebird Subscription.

To get help through the ODBC Driver for Firebird Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for Firebird Registration number.

e Full ODBC Diriver for Firebird edition name and version number. You can find the version
number in DLL version information.

¢ Versions of the Firebird server and client you are using.

e A detailed problem description.

e If possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Firebird.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
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Using ODBC Driver

1. Installation

2. Product Activation

3. Connecting to Firebird

4. Connection String Parameters

5. Sandboxed Apps on macOS
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6. Using with iODBC
7. Enabling ODBC Tracing

8. Supported Data Types
9. Supported ODBC API Functions
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3.1 Installation
ODBC Driver for Firebird currently supports the following platforms: Windows, macOS, and
Linux, both 32-bit and 64-bit.

See how to install Devart ODBC Driver for Firebird :

e \Windows

e Windows Silent

e macOS
e Linux DEB
e Linux RPM

© 2015-2024
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3.1.1 Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.
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i5! setup - Devart ODBC Driver for Firebird - x
devo r‘t Welcome to the Devart ODBC Driver for
Firebird Setup Wizard
This will install Devart COBC Driver for Firebird 3.0.2 on your
computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

WARNIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for Firebird

3. In case if you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the
driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.
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i setup - Devart ODBC Driver for Firebird — >
Select Components
Which components should be installed? devart

Select the components you want to install; dear the companents you do not want to
install. Clid Mext when you are ready to continue.

Full installation w
Devart ODBC Driver for Firebird 4.8 MB
. [] Driver for Win32 2,1ME
. [“] Driver for Wing4 2,8 MB
Help and Manual 8,7 MB

Current selection requires at least 15,3 MB of disk space.

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm

4 Downlo

D Music v < >

1item =
8. Click Next.

9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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See also:

¢ |nstallation on macOS

¢ Install Linux DEB package

¢ |nstall Linux RPM package

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
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3.1.2 Windows Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCFirebird.exe /SILENT /ActivationKey=ylc7nmgdu2341laszxcvONGurjfhxm9
DevartODBCFirebird.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtri]l
Note: The installation is performed by entering a license key.

DevartODBCFirebird.exe /SILENT /ActivationFile=d:\1l1ic.key
DevartODBCFirebird.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.1.3 macOS

Prerequisites
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ODBC Diriver for Firebird works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Firebird is compatible with iODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Firebird will be installed,
but it will require manual modification of configuration files of these managers.

Installing ODBC Driver for Firebird
1. Go to Security & Privacy settings in the System Preferences.

2. Enable the App Store and identified developers option in the Allows apps downloaded

from section.
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[ ] 4 G Security & Privacy Q

m FileVault = Firewall  Privacy

A login password has been set for this user Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

) App Store
° App Store and identified developers

o’
Eﬁ Click the lock to prevent further changes. Advanced... ?

Note: If the options in Allow apps downloaded from section are grayed out, click on the

lock icon and enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, press the Allow button to proceed with the installation.
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® O = Install Devart ODBC Driver for FireBird ]

Welcome to the Devart ODBC Driver for FireBird Installer

This will install Devart ODBC Driver for FireBird 2.5.1 on your

@ Introduction computer.
Read Me WARNING: This program is protected by copyright law and international
} treaties
License

Registration
Destination Select
Installation Type
Installation

Summary

Continue

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver [

To continue installing the software you must agree to the terms of
the software license agreement.

g Click Agree to continue or click Disagree to cancel the installation and
Rei guit the Installer.
o Lic
Re MS
! Read License Disagree Agree
De|

Installation Type
INTRODUCTION

Installation

§ This Devart end-user license agreement ("Agreement”) is a legal

Summary agreement between you (either an individual person or a single legal
entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

7. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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@®C

@ Introduction
© Read Me

© License

© Registration

Destination Select
Installation Type
Installation

Summary

‘& Install Devart ODBC Driver s
Registration

License information
Please enter the path to the file containing the activation key
received when purchasing the preduct. If you have no
activation key, select Trial Version.

I Trial
°' Activation Key

d1asbaFDhafkésHdrnfbvwncnve TR4i11+GDVFC465furdxawBMNYCru
bbv3546ifa6a7litkbbhuvDFaHre2965+gvefxixtrd23nmbCVBrut!/
q1f2b7==chhfvritviXcvRfyurkawRThabvyvuTrwo09/65ii TRABMNNYVCrb
b4 56T Kiiguuvbh

Load Activation Key ...

Go Back Continue

8. If you have the activation key file, click the Load Activation Key button and browse to it.
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[ NON | [l Desktop
4 = [0 o1 == | #~ 0 a Q. Search

Favorites

@ AirDrop A

&Y iCloud Drive A . CTHT |
& All My Files test
pé\; Applications

=] Desktop

@ Documents

0 Downloads

Devices
Remote Disc

Shared
server

@ Al
T m——

[

9. To complete the installation click Continue, then Install buttons.
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314

O & Install Devart ODBC Driver fa)
The installation was completed successfully.
Introduction
Read Me
License
Registration
3 0 - -
Destirstion Sekoat The installation was successful.
bl bl The software was installed.
Installation
Summary

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ |nstall Linux DEB package

¢ Install Linux RPM package

© 2015-2024
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Linux DEB

Prerequisites

Provide Feedback
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ODBC Diriver for Firebird works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Firebird is compatible with UnixODBC driver manager. You can install the

unixODBC driver manager using the command below:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

In case when using other ODBC driver managers, ODBC Driver for Firebird will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from a DEB package, for
example, on Ubuntu. There are two ways to install the driver either manually or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-
click it.

3. In the opened dialog, click the Install button.
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Ubuntu Software

devartodbcfirebird

devartodbcfirebird

New level of Functionality and performance in data access via ODBC

Install

Devart ODBC Driver for Firebird provides a high-performance and feature-rich connectivity solution For
ODBC-based applications to access Firebird databases from Windows, macOS, Linux, both 32-bit and 64-bit.
Full support for standard ODBC API functions and data types implemented in our driver makes interaction of
your database applications with Firebird fFast, easy and extremely handy.

Website

Details

Version 3.0.1
Source Unknown
Size 3,4 MB

Coon-free 38 3rd party |

This software comes from a 3rd party and may contain non-free components.

4. If the installation is successfully completed, the Install button changes into the Remove

one.

Command-line installation
1. Download the DEB package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the

selected one);

2. Run the 'Terminal' program;

3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):
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cd ~/Downloads/

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ [

4. To install the devartodbcfirebird_i386.deb on a 32-bit system, use the following command:

sudo dpkg -i devartodbcfirebird_i386.deb

test@ubuntu:~5 cd ~/Downloads/f
test@ubuntu:~/Downloads$ sudo dpkg -1 devartodbcfirebird i386.deb |

5. To install the devartodbcfirebird_amd64.deb on a 64-bit system, use the following

command:

sudo dpkg -i devartodbcfirebird_amd64.deb

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcfirebird amdé4.deb

6. Driver is installed successfully.

test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcfirebird i386.deb
Selecting previously unselected package devartodbcfirebird.

{Reading database ... 238038 files and directories currently installed.)
Preparing to unpack devartodbcfirebird i386.deb ...

Unpacking devartodbcfirebird (3.0.1)
Setting up devartodbcfirebird (3.08.1)
test@ubuntu:~/Downloads$ |

To activate the driver, perform the steps described in the Product Activation article.

See also:
¢ Install Linux RPM package
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¢ |nstallation on Windows

¢ |nstallation on macOS

© 2015-2024
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3.1.5 LinuxRPM

Prerequisites
ODBC Diriver for Firebird works under control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.
ODBC Diriver for Firebird is compatible with UnixODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Firebird will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from an RPM package, for
example, on CentOS. To install the driver, you should download the .rpm package and install
it via the command line. See the detailed description of these steps below:

1. Download the RPM package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Konsole' program;
3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):

cd ~/Downloads/
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4. To install the devart-odbc-firebird.i386.rpm on a 32-bit system, use the following

command::

sudo rpm -ivh devart-odbc-firebird.i386.rpm

[test@localhost ~]% sudo rpm -ivh devart-odbc-firebird.i386. rpm

To install the devart-odbc-firebird.x86_64.rpm on a 64-bit system, use the following

command::

sudo rpm -ivh devart-odbc-firebird.x86_64.rpm

54 ~]1% cd ~/Downloads/
57x64 Downloads]$ sudo rpm -1ivh devart-odbc-firebird.x86 64.rpm

do rpm -1vh devart-odbc-firebird.x86 64.rpm

A e [ LO00rs]

.natallinq...

FEA R [ 100%: ]

To activate the driver, perform the steps described in the Product Activation article.

See also:
¢ Install Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS

© 2015-2024
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3.2 Product Activation

See how to activate Devart ODBC Driver for Firebird :
e Obtaining Activation Key

e Activation on Windows

e Activation on macOS

e Activation on Linux

¢ Where to see the license information
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3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
account.

4. To login to the Customer Portal, use your Username and Password from the registration
email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:
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Activation Key

ulwTiCODBNGAEDFghMNzjuTAToDjwgLNmX Meuy+kt2YisW39cp39ih89)Z6mCh
MhlQfsILhFIgrh QWX TEmuz 1)i+IQycFEPkmX+Z5Y QP XtTebxgMUSHsUdPNsKis
93Ee03mgHGadwIIHSQXuKKBzPIxDI8 1io5ffSvmpp|LEEXvIaOkPRh4araaudUiK
rodrz GOxukSjdOMNfxzeykQ==

COPY TO CLIPBOARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows

e Activation on macOS

e Activation on Linux

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.2.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

i&'

Data Sources
(QDBC)

2. In the System DSN tab click the Add button.
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E ODBC Data Source Administrator (4-bit) >

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QODBC Driver for BigCommerce_x32 32-bit Devart QDBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QODBC Driver for MailChimp_x32 32bit Devart QDBC Driver far MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QDBC Driver for MySQL 32bit 32hit Devart ODBC Driver for MySQI ¥
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apply Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

37

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key...

Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.
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3.2.3 Activation on macOS

Driver Activation After Installation

If you don’t activate your driver during installation, you can activate it later by following the
steps:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and
paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed (for Devart

ODBC Driver for Firebird it is /Library/ODBC/Devart/Firebird by default).

See also:

e Activation on Windows

e Activation on Linux
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3.2.4 Activation on Linux

Driver Activation After Installation

If you did not activate the driver during installation, you can activate it later:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed:
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- for the DEB package of Devart ODBC Driver for Firebird, it is /usr/share/devart/odbcfirebird
by default;

- for the RPM package of Devart ODBC Driver for Firebird, it is /usr/local/devart/odbcfirebird
by default.

See also:

e Activation on Windows

e Activation on macOS

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.2.5 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources

(ODBC)

2. Open the System DSN tab and click the Add button
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E ODBC Data Source Administrator (4-bit)

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QODBC Driver for BigCommerce_x32 32-bit Devart QDBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QODBC Driver for MailChimp_x32 32bit Devart QDBC Driver far MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QDBC Driver for MySQL 32bit 32hit Devart ODBC Driver for MySQI ¥
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apply Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab
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General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . Ok Cancel

See also
e Product Activation
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3.3 Connecting to Firebird

See how to connect the Devart ODBC Driver for ODBC Driver for Firebird:
¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
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3.341

Windows

Windows DSN Configuration
After installing the driver, create a DSN for Firebird in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe t0O create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for ODBC Driver for Firebird and click Finish. The driver
setup dialog will open.

5. Enter the connection information in the appropriate fields.
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Devart ODBC Driver for Firebird Configuration o

General  Advanced Settings  License  About

Data Source Mame |Devart QDBC Firebird |

Description |Dri'~rer for Firebird |
Server 127.0.0.1 | Port |3050 |
Database |D:1|,ib‘|,EMP'TT.FDE! |

User ID |5YSDBA |

Password | sssssnnes | Save Password

Client Library |C:\Prugram Files\FirEbird‘n,FirEbird_Z_E‘n,bin‘n,FndiE| -
Protocol TCP v

Test Connection - Cancel

6. You may test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also
Connection Options
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3.3.2 Mac

macOS DSN Configuration

After the driver is installed, DSN with the name DEVART_FIREBIRD is created. You can use
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it to test a connection with FIREBIRD server. For this, perform the following steps:
1. Run the iODBC utility of the required bitness. Find the DEVART_FIREBIRD section and

click the Configure button:

] iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD Devart ODBC Driver for Firebird Remava
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB, —
DEVART_MYSQL - Devart ODBC Driver for MySQL
DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSG Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazen R
DEVART_SQLAZURE - Devart ODBC Driver for SAL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SQL Serve

_ System Data Source Mames create systems-wide CDBC Data Names that resolve to Data
: E Source connection information.

Cancel
-

2. In the appeared dialog, specify the required connection settings and click OK.
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® 00 Setup of DEVART_FIREBIRD

Data Source Name (DSN)  DEVART_FIREBIRD
Comment

Keyword Value

Data Source 127.0.01

Database JUsers/test/Documents/fdb.fdb
Port 3080

User D svsdba

Password FRETEES

+ —

3. Now click the Test button to establish a test connection to your data source.

47
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@ iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD Devart ODBC Driver for Firebird Remova
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB| ———
DEVART_MYSQL - Devart ODBC Driver for MySQL

DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSC
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SOL Serve

_____ System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
E Source connection information.

Using Client Library with SIP enabled

When SIP is enabled on your machine, put the client library file in either of these directories
and specify the path to the client library in the Client Library connection parameter.

¢ /Applications
e /Library

e /usr/local

If you place the client library in either of the following directories when SIP is enabled, the
driver will not be able to access the library due to protection for these parts of the system by
SIP.

e /System

e Jusr
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e /bin
e /sbin
e /var

¢ Apps that are pre-installed with OS X

If you would like to disable SIP on your system, follow the instructions. Read more about
System Integrity Protection in macOS documentation.

See Also
Connection Options

© 2015-2024
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3.3.3 Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name DEVART_FIREBIRD is
created. You can use it to test the connection with the FIREBIRD server. For this, perform the

following steps:

1. Open the odbc.ini file located in the /etc folder. Find the DEVART_FIREBIRD section and
specify the required connection settings:

User ID=<your Firebird User Name>

Password=<your Firebird password>

Server=<your Firebird server address>

Port=<your Firebird Port>

Database=<your Firebird database name>

Client Library=<path to the used Firebird client library>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_FIREBIRD
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3.4

test@ubuntu:~% isql -v DEVART_FIREBIRD

Connected!

sgl-statement
help [tablename]

See Also
Connection Options

© 2015-2024
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Connection String Parameters

Firebird ODBC Connection String Parameters

The following table lists the connection string parameters for Firebird.

Paramet

er

Clientlibrapyg fu path to the Firebird client library - for example, D: \fbclient.d1l
ry

Database | The full path to the database to connect to.

Description

Password | The password of the Firebird user.

Port The port number for the connection. 3050 by default.
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The network protocol for the connection to the Firebird server. Possible

values:

Protocol TCP Uses TCP/IP to connect to the server.
NetBEUI |Uses NetBEUInamed pipe for connection

SPX Uses the SPX protocol for connection

Server Serves to supply the server name for login.

User ID Used to supply a unique User ID for login.

Advanced Settings

AllowNullSt
ringsInMeta Some parameters don't accept null values when retrieving metadata. if a
data

third-party tool passes a null value to such a parameter, the driver returns
EmptyString : L :

an error. These options ensure compatibility with such third-party tools.
sAsNullInMe
tadata

Used to set the character set that the driver uses to read and write
Charset

character data.

Connection The option for passing additional connection parameters separated by
Options comma to the Firebird server.
If the default port (3050) is used in the DSN settings, it will be cut out of the
connection string for compatibility with certain versions of Firebird. That

F Usi
Sros Beils said, other versions of Firebird won't work correctly if the default port is not

Default
value explicitly specified in the connection string. The Force Using Default Port
option forces the driver to keep the default port in the connection string.
The default value is False.
Sets the behavior corresponding to the ODBC specification version
CEER expected by a third-party tool. The behavior of the ODBC driver can be
Behavior changed by calling the sQLSetEnvAttr function to set the

SQL_ATTR_ODBC_VERSION environment attribute. Some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call
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SQLSetEnvAttr with the needed version, or pass an incorrect value. In this

case, the behavior can be explicitly set in the connection string.
)

The default value. ODBC behavior is determined by a third-party tool.
2

ODBC 2.x behavior is explicitly set.
3

ODBC 3.x behavior is explicitly set.

RegionalNum Enables the use of local regional settings when converting numbers to

berSettings|strings.
Reglonalbat Enables the use of local regional settings when converting dates and
eTimeSettin| _
times to strings.
gs
Role Used to specify the role that has been granted to the user.
Sets the string value types returned by the driver as Default, ANSI, or
Unicode.
Default
The driver defines the string types.
Ansi
All string types are returned as SQL_CHAR, SQL_VARCHAR, and
String SQL_LONGVARCHAR.
Types

Unicode
All string types are returned as SQL_ WCHAR, SQL_WVARCHAR, and
SQL_WLONGVARCHAR.
Note: Set the parameter to Ansi or Unicode if your third-party tool supports
only ANSI or Unicode strings.
Use Unicode Enables or disable Unicode support. The default value is True.
Enables or disables compression of data over the wire at global or
WireCompres individual database level. Use Connection Options to pass this
sion connection parameter, for example WireCompression=True. Disabled by

default.
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3.5

Note: You should place z1ib1.d11 in the same location as fbclient.d1l.

Sample Firebird ODBC Connection String

DRIVER={Devart ODBC Driver for Firebird};Data
Source=127.0.0.1;User ID=sysdba;Password=masterkey;Client
Library=D:\fbclient.d11;Database=D:\mydb.fdb

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback

Reserved.

Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access iODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When

accessing a data source from an application like Excel through the ODBC driver for Firebird,

you may get an error message saying that the driver is unable to create a file.

Note that all third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the

Apple logo).

2. Select Utilities > Terminal.

3. In the Terminal window, enter csrutil disable.

@ L ] Terminal — -bash — 80x 24

-bazh-3.2# csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes to take effect.

—bash-3.2# rebnntl

4. Restart your computer.
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3.6

5. Enter csrutil status to check the status of SIP.

i & 3y test — paserver — -bash — B(x24

tests—imac-2:~ test$d csrutil status
System Integrity Protection status: disabled.
tests-imac-2:~ test$ [J

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.
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Using with iODBC

Using the Driver with iODBC

Among known issues with iODBC driver manager is incorrect handling of the following ODBC
data types:

e SQL_WCHAR
e SQL_WVARCHAR
e SQL_WLONGVARCHAR

For this reason, we recommend using the following data types instead:
e SQL_CHAR

e SQL_VARCHAR
e SQL_LONGVARCHAR

If you have to work with the SQL_WCHAR, SQL_WVARCHAR, and SQL_WLONGVARCHAR
data types, we recommend that you use the unixODBC driver manager rather than iODBC.

© 2015-2024
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3.7 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.
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3.8

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the

[opBC] section of the /etc/odbcinst. ini file, for example:

[ODBC]
Trace=Yes

TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.
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Supported Data Types

Data Type Mapping

The Devart ODBC Driver for Firebird supports all Firebird data types.

The following table describes how the Firebird data types are mapped to the ODBC data

types.

Firebird Data Types
INT64

TIMESTAMP
DECIMAL
FLOAT

BLOB

INTEGER
DECIMAL(18, 4)

CHAR(x) CHARACTER SET
UNICODE_FSS

BLOB SUB_TYPE TEXT
NUMERIC

VARCHAR(x) CHARACTER SET

ODBC Data Types
SQL_INTEGER

SQL_TYPE_TIMESTAMP
SQL_DECIMAL
SQL_REAL
SQL_LONGVARBINARY
SQL_INTEGER
SQL_DECIMAL

SQL_VARCHAR

SQL_LONGVARCHAR
SQL_NUMERIC

SQL_VARCHAR
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UNICODE_FSS

DOUBLE SQL_DOUBLE

SMALLINT SQL_SMALLINT

DECIMAL(10, 4) SQL_DECIMAL

CHAR SQL_CHAR

VARCHAR SQL_CHAR

CHAR(38) SQL_CHAR

© 2015-2024
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3.9 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Firebird supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle v, ISO 92 connection,

statement, or

descriptor handle.

Connects to a

specific driver by
SQLConnect v ISO 92

data source name,

user ID, and
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password.
Connects to a
specific driver by
connection string or
SQLDriverConnect y ODBC requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
SQLAllocEnv v Deprecated environment handle

allocated from driver.

Obtains a
SQLAllocConnect v Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose
Returns the list of

available data
SQLDataSources v ISO 92

sources, handled by

the Driver Manager

Returns the list of

installed drivers and
SQLDrivers v ODBC their attributes,

handles by Driver

Manager

Returns information
SQLGetlinfo v ISO 92 .
about a specific
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SQLGetFunctions

SQLGetTypelnfo

ISO 92

ISO 92

driver and data
source.

Returns the functions
supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr

SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ISO 92

ISO 92

ISO 92

ISO 92

Purpose
Sets a connection

attribute.

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement

attribute.

Returns the value of
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a statement attribute.

_ Sets a statement
SQLSetStmtOption v Deprecated

option

. Returns the value of
SQLGetStmtOption v, Deprecated

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name  Support Standard Purpose
Allocates a
SQLAllocStmt v Deprecated
statement handle
Prepares an SQL
SQLPrepare v ISO 92 statement for later
execution.

Assigns storage for
SQLBindParameter v ODBC a parameterinan
SQL statement.

Returns the cursor

SQLGetCursorNam name associated
v, ISO 92 .
e with a statement
handle.
SQLSetCursorNam Specifies a cursor
v ISO 92
e name.
Sets options that
SQLSetScrollOption
v ODBC control cursor
S
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose
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Executes a prepared
SQLExecute v ISO 92
statement.

_ Executes a
SQLExecDirect v ISO 92
statement
Returns the text of an
) SQL statement as
SQLNativeSq| v ODBC
translated by the
driver.
Returns the
] description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina
statement.
Used in conjunction
with SQLPutData to
supply parameter
SQLParamData v ISO 92 PPYP
data at execution
time. (Useful for long
data values.)
Sends part or all of a
data value for a
SQLPutData ' ISO 92
parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
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SQLRowCount

SQLNumResultCols

SQLDescribeCol

SQLColAttribute

SQLColAttributes

SQLFetch

SQLFetchScroll

SQLExtendedFetch

SQLSetPos

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

ISO 92

ISO 92

Deprecated

ODBC

Returns the number
of rows affected by
aninsert, update, or
delete request.
Returns the number
of columns in the
result set.
Describes a column
in the result set.
Describes attributes
of a columnin the
result set.
Describes attributes
of a columnin the
result set.

Returns multiple
result rows.

Returns scrollable
result rows.

Returns scrollable
result rows.
Positions a cursor
within a fetched
block of data and
enables an
application to refresh
data in the rowset or
to update or delete

data in the result set.
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SQLBulkOperations v ODBC

Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name Support Standard
SQLError v Deprecated
SQLGetDiagField v ISO 92
SQLGetDiagRec v, ISO 92

Purpose
Returns additional

error or status

information

Returns additional
diagnostic
information (a single
field of the
diagnostic data
structure).

Returns additional
diagnostic
information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About

Database Objects (Catalog Functions)

Function Name Support Standard

Purpose
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SQLColumnPrivileg

es

SQLColumns

SQLForeignKeys

SQLPrimaryKeys

SQLProcedureColu

mns

SQLProcedures

SQLSpecialColumn

ODBC

X/Open

ODBC

ODBC

ODBC

ODBC

X/Open

Returns a list of
columns and
associated
privileges for one or
more tables.
Returns the list of
column names in
specified tables.
Returns a list of
column names that
make up foreign
keys, if they exist for
a specified table.
Returns the list of
column names that
make up the primary
key for a table.
Returns the list of
input and output
parameters, as well
as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
procedure names
stored in a specific

data source.

Returns information
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about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
S that are
automatically
updated when any
value in the row is
updated by a
transaction.
Returns statistics
about a single table
SQLStatistics v, ISO 92 and the list of
indexes associated
with the table.
Returns a list of
tables and the
SQLTablePrivileges v, ODBC privileges
associated with
each table.
Returns the list of
SQLTables y X/Open table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

SQL Transact v Deprecated Commits or rolls
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back a transaction
Commits or rolls

SQLEndTran v ISO 92
back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees alll
resources
associated with the

statement handle.

Closes a cursor that

SQLCloseCursor v ISO 92 has been opened on
a statement handle.
Cancels an SQL
SQLCancel v ISO 92
statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
. Closes the
SQLDisconnect v ISO 92
connection.
Releases an

environment,
SQLFreeHandle v ISO 92 connection,
statement, or

descriptor handle.

SQLFreeConnect V' Deprecated Releases connection
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handle.

Releases an
SQLFreeEnv v Deprecated

environment handle.
© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Firebird with ODBC-compliant tools.

e DBeaver
e Denodo

e Oracle Database Link

e Microsoft Access

e Microsoft Excel

e OpenOffice and LibreOffice

* PHP
e Power Bl
* Python

e QlikView

e SQL Server Management Studio

e SSIS

e Tableau
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41 Usingin DBeaver

DBeaver Overview
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DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing
e SQL scripts management

e Data export/import

e Data backup

e DDL generation

¢ ER diagrams rendering

¢ Test data generation

e BLOB/CLOB support

e Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from Firebird via the Open Database Connectivity driver.

Creating an ODBC Data Source to Use Firebird Data in
DBeaver

1. Click the Start menu and select Control Panel.
2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system
or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Firebird in the list.
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5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Firebird with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR.

Devart ODBC Driver Configuration et

General Advanced settings License About

Meta Data
= - - » - . - » -
Connection
——
L
Compatibility
ODBC Behawior Default b
String Types Ansi (SQL_CHAR, SQL_VARCHAR, SOL_LOMC ~

Use Local Regional Settings when converting to string

[ ] Mumbers [ ]Dates and times

Test Connection vor Cancel

Connecting to Firebird Data from DBeaver via ODBC
Driver for Firebird

Follow the steps below to establish a connection to Firebird in DBeaver.

1. In the Database menu, select New Database Connection.
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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fy Connect to database O =

Generic JDBC Connection Settings

, _ = O0DBC
ODBC connection settings

General Driver properties S5H Proxy

JDBC URL: ‘ jdbciodboDBEAVER_DATASOURCE

Database/Schema: | DBEAVER_DATASOURCE |

User name: ‘ |

Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Firebird Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all
the tables in Firebird database. To view and edit the data in a table, you need to right-click on
the target table name and select View data.The content of the table will be displayed in the

main workspace.

‘¢ DBeaver .1.5 - SALE
File Edit Mavigate Search S50L Editor Database Window Help

LRSI -2 N R T~ a0 D -
f® Databa.. 2 Projects = B | PASALE 22
- - . .
¢ -= | = FE Properties | . Data | 54 ER Diagram =
Enter a part of table name here -
FB RB_ITEM ~ BB SALE |y
&5 RE_JOIN T €D sale DATE T3|123TERMINALID T3| 123 GROSS AMT T3 122
FF RE_TABLE G
EB REP_GABARITO 1 20151224 : e
e p— 2 2015-12-24 3 1.1
- % 3 2015-12-24 3 1.1
BB REP_TEXTOS_HIST s 2
v BB SALE L 4 2015-12-24 3 1.1
BN Columns T s 2015-12-24 3 1.1
BB Unique Keys 3 2015-12-24 3 1.1
B Foreign Keys 7 2015-12-24 3 1.1
B indexes 8 2015-12-24 3 1.1

If you want to write a custom SQL query that will include only the necessary columns from the
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4.2

table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

f= Databa.. 2 Projects — B EBSALE IT *«ODEC - Firebird_x64> Script-5 3
*}'_ - | - 7 Y SELECT GROSS_AMT, VAT_AMT, NET_AMT FROM SALE;
Enter a part of table name here b,
EE RE_ITEM o
FH RE_JOIN p—
P RB_TABLE B saLE =2
EE REP_GABARITO «T SELECT GROSS_AMT, VAT £ |23
FH REP_TEXTOS R R N
BB REP. TEXTOS_HIST g 123 GROSS_AMT T3] 123waT_amT T3 | 125 NET AMT IS
v B8 SALE i 1| 111 22.2 23.3
Columns 2_ 111 22.2 33.3
Unique Keys % 3 | 11.1 22.2 33.3
B Foreign Keys '[; 4 1.1 22.2 33.3
M indexes "5 | 1.1 222 33.3
P References 5— 111 22 33.3
B SECOND 7| 1.1 222 33.3
F8 SECONDTABLE 3 1.1 552 333
BB SEG_ACSSMODULO v 9 | 1.1 222 23.3
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Using in Denodo

Troubleshooting ODBC Connection in Denodo

When you attempt to access Firebird from Denodo with default settings, you may get an
'Unexpected error creating a connection: Unable to validate object Received exception with
message 'Unable to validate object". To resolve the error:

1. Select File > New > Data Source > ODBC in Virtual DataPort Administration Tool.

2. Click Connection Pool configuration.

3. In Ping query, change select 1 t0 Select 1 From DB$DATABASE, then click Ok.
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g *new_datasource

Connection Pool Configuration

Initial size: 4
Maximum number of active connections: 20

Test connections
Select 1 From DBSDATABASE|

Ping query:
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4.3 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
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standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Firebird, create an initialization file for

your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initFirebird.ora. YOu need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNeEcT_INFO parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Firebird

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_NamMe) must be the same in 1istener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=
(SID_NAME=Firebird)

(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access
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Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The s1p must match the value specified in the
listener.ora file.
Firebird =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))

(CONNECT_DATA =
(SID = Firebird)

)
(HS = OK)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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4.4 Using in Microsoft Access

Connecting Microsoft Access to Firebird Using an ODBC
Driver
This article explains how to connect Microsoft Access to Firebird through the standard ODBC

interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
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spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Firebird data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. lItis
assumed that you have already installed and configured a DSN for ODBC driver for Firebird.
For the purpose of this article, we tested an ODBC connection to Firebird through our ODBC

drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in Firebird.

Importing Firebird Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Firebird and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.
9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Firebird Data in Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.
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2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Firebird and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Firebird table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the
selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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4.5 Using in Microsoft Excel

Connecting to Firebird from Microsoft Excel using ODBC
Driver for Firebird

You can use Microsoft Excel to access data from a Firebird database using ODBC
connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet

and present it as a table. Make sure that you use matching Excel and ODBC Diriver, e.qg. if
you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Firebird with Get & Transform (Power Query)
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e Connecting Excel to Firebird with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Firebird with the Query Wizard

e Connecting Excel to Firebird with Microsoft Query

e Connecting Excel to Firebird with PowerPivot

Connecting Excel to Firebird with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to Firebird from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Firebird.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.

H Bookl - Excel Evgeniy Lemeshov 2| |
File Home Insert Page Layout Formulas Review View Help @ Tell me 9 Share
(& [& |_ e A [Z1A ~ [E Be g g
= IR AR EREIE
=1 [ - .
Get Refrash z| Sort Filter Text to What-If Forecast Outline
B = Y, = - B -
Data - All - i Columns =2 Analysis = Sheet M
Gi Sort & Filter Data Tools Forecast L
ﬁ From File L
c b
Ty
From Database L ~ - - - ' ' ; =
— 1 3
Ay m - | + 100%
= am From Azure 4 From Table/Range
L=y
__E) From Online Services » _@ From Web
B =
_.¢. From Qther Sources L4 _ From Microsoft Query
B
\_)r"j Combine Queries 4 _.¢. From QDEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the
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credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

From ODBC

Data source name (DSN)

| Devart ODBC Dniver b

4 Advanced options
Connection string (non-credential properties) (optional) &

501 statement (optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (optional)
(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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ODBC driver X
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an ODEBC driver,

Windows

User name
Database myusername

Password

SR NeREeE

Credential connection string properties (optional) (0

Back Cancel

If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom ¢'d5”: evart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (O
Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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O =
Navigator
Al | FIsH B
Select multiple items ID CATEGORY SPECIES_NAME  COMMON_NAME NOTES
Display Options ~ Pé 1|Triggerfish null Clown Triggerfish Bin
)
EH EXECREG 2 Snapper null Red Emperor Bin
M FAC WEN DETALLE ~ 3| Wrasse null| Giant Maori Wrasse Bin
4 Angelfish null Blue Angelfish Bin
P FAC_VEN_DETALLET s :
5 Cod null| Lunartail Rockcod Bin
FILA_EMTREGA_AVI...
= - - &|Scorpionfish null| Firefish Bin
B FIRST 7 Butterflyfish null Ornate Butterfiyfish Bin
£ FIsH 8|5Shark null Swell Shark Binv
B FUNCAD LW 9| Ray null| Bat Ray Bin
- < >
Select Related Tables load |~ Transform Data Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further

work with it.

H ©- Book? - Excel Evgeniy Lemeshov O x

File Hom | Inser | Page | Form | Data | Revie | View | Help | Table Design | Query Q Tell me ,!:fi. Share

Al - e v
A B = D E|~

1

2 | 1 Triggerfish Clown Triggerfish

3 | 2 Snapper Red Emperor

4 | 3 Wrasse Giant Maori Wrasse

5 | 4 Angelfish Blue Angelfish

6 | 5 Cod Lunartail Rockcod

7| 6 Scorpionfish Firefish

8 | 7 Butterflyfish Ornate Butterflyfish

9 | 8 Shark Swell Shark

10 | 9 Ray Bat Ray -

Sheet3 | Sheetl | & 1 3

Connecting Excel to Firebird with Data Connection
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Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.
2. In the opened dialog, select ODBC DSN and click Next to continue.
3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Firebird with the Query Wizard

You can use this option to create a simple query for retrieving data from Firebird to Excel via
ODBC driver.

1. Open Excel, in the main menu, click the Data tab.
2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.
3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to Firebird with Microsoft Query
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You can use this option to create a more complex query for retrieving Firebird data to Excel
via ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Firebird). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click
the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Firebird with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Firebird), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.
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4.6 Usingin SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Firebird from SQL
Server Management Studio using ODBC Driver for Firebird.

¢ Creating a Linked Server

¢ Troubleshooting in SSMS
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46.1 Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for Firebird and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Firebird from SQL Server Management
Studio using ODBC Driver for Firebird

You can use the Microsoft SQL Server Management Studio to connect your Firebird data to
an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Firebird
and merge them with your SQL Server database. You can create a linked server with one of
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these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Firebird:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Firebird

You can follow the steps to create a linked server for Firebird in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

Firebird . Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Firebird databases through SQL Server.

Retrieving Data From Firebird

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Chject Explorer
Connect~ ¥ ¥

(WIS

= I x

Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL

wh search.CollatorDs0O

= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - C

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers

Select a page

& General L7 scipt ~ @ Hep

Provider options:

Enable MName

U
U
[]

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server

[Cynamic parameter
MNested queries
Level zero only
Allow inprocess
Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator ¥
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
# General
& Security
& Server Options b
Server type:
() 5QL Server
(®) Other data source
Pravider: Microsaft OLE DB Provider far ODBC Drivers w
Product name: | |
Data source: | |
Provider string: | |
Location | |
Catalog | |

Connechon

Now you need to input the Linked Server name, e.g. FIREBIRD. In the Product Name and
Data Source fields you need to indicate the System DSN that you've previously created -
more info on System DSN setup can be found here.
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H New Linked server = O *
Select a page [ o 'ﬂHeIp
& General
& Security
& Server Options Fimles— FIREBIRD
Server type:
() 50L Server

(®) Other data source

Provider: Microsoft OLE DB Provider for ODBC Drivers ~

Product name: | Devart ODBC Driver for Firebird |
Data source: |F|rebird |
Provider string: | |
Location | |
Catalog | |

Connection

The Firebird tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:

File Edit View Project SOL Complete Tools Windoy
P00 (8B -2 | Brewauey B R &
: | | P Execute

———————————————————————————
Object Explorer * I x

Connect~ ¥ *¥ (VIS

= E EVGEMIYL\SQLEXPRESS (5QL Server 14.01000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers
H oRacCLE
B POSTGRESGL
J saLTe

BEBEEBE

Enter your SQL query in the editor window and click Execute to run the query:
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L4 SQLQuerys.sql - EVGENIVL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St.., Quick Launch (Ctrl+Q) P = B x
File Edit View Query Project SQOL Complete Tools Window Help
fte-o B -t B P Brewauey BR S S XTI D0 A5 S| A=
£ \7| master - | P Execute Vv S | 2" Ba i—“||m'?i|m'—_'l| = '°_§|=§ §=|'@=
Object Explorer Wl SOLQuery6.sql - E..S.master (sa (34))* # X -
as I = * . =
Connect= % "% O SELECT * FROM [FIREBIRD]...[SALE]; _:
= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 » Bl
Databases
Security
=] Server Objects -
A 100 % -
Backup Devices
£ 17 Linked Servers ES Resuts [ Messages
Providers (SALE DATE TERMINALID GROSS_AMT VAT AMT NET_AMT ~
B AMAZON REDSHIFT 1 0151224 3 11.10 2220 3330
g st 2 20151224 3 11.10 2220 3330
B BIGCOMMERCE i 7 20151224 3 11.10 2220 3330
5 S 4 8 20151224 3 11.10 2220 3330
5 9 20151224 3 11.10 2220 3330
= 8 FREBIRD & 10 20151224 3 1110 2220 3330
2 M Catalogs 70 20151224 3 11.10 2220 33.30
System Catalogs g 12 20151224 3 11.10 220 3330
= @ default s 13 20151224 3 11.10 2220 3330
Tables 0 14 20151224 3 11.10 220 31330
WViews 1115 20151224 3 11.10 2220 3330
H FRESHBOOKS 12 18 251224 3 11.10 2220 33.30
B INTERBASE o PR A01E1m A A 1110 2990 aq.an h
< > @ Query execut.. | EVGENIYL\SQLEXPRESS (14.0 RTM) | sa (54) | master | 00:00:08 | 35 rows

As a result, you can see the contents of the selected table retrieved directly from the Firebird
account you are connected to.

See also
¢ Troubleshooting SSMS
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46.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its
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properties:

-
%. Component Services

. File Action

View Window Help

Console Root
4 . Component Services
a [ Computers
4 (& My Computer

» [ COM+ Applicatio
1 (] DCOM Config
& [ -] Running Processe
& [ Distributed Trans:
I E Ewvent Viewer (Local)
3 f.a Services (Local)

Windows... Windows R... Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo... Windows ...  WMIPro.. WMIProvi...

¥ & & @&

Micrasoft... Microsoft.L.. MicroseftV... Microsoft..

ApplD
MMC ALY MSMDPP - MsRdpbess...
Applicati... LIZE

¥ ¥ & @

MSTTS Mahimicse.. MAP Agent Map Elevated
DecObj Cla... Service COM class
NCLUA MDFAPI netman netprofm

¥ ¥ & @

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions 4

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

| Advanced Security Settings for {2206CDEQ-19C1-1101-89E0-00C04AFDTAB2S}

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

Current owner:

< - s i = iy et o -

Change ownerta:

You can take or assign ownership of this object f you have the required permigsions or privileges.

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At

Leam about ohject ownership

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:

. R e e r oy T R R PP 0.
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-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"
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4.7 Using in OpenOffice and LibreOffice

Connecting to Firebird from OpenOffice and LibreOffice
using ODBC Driver for Firebird
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Firebird data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Firebird, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Firebird, or you can click

Browse, double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection

3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Firebird and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard

Steps

1.5elect database
2.5et up ODEC connection

3.5et up user authentication

: .ESEWE and proceed

Help

Decide how to proceed after saving the database

Do you want the wizard to register the database in OpenOffice?

® Yes, register the database for me

(O Mg, do not register the database

After the database file has been saved, what do you want to do?
Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

<< Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you

want to store it.
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S save &s
« o v
Organize -

& This PC

M 3D Objects

B Deskiop

|j_: Documents

4 Downloads

D Music
&=| Pictures
B videos

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

- Hide Folders

@ Mew Database

i Local Disk (C2)

v O Search DB

Date modified Type

101

05.06.2019 16:43 OpenDocumer

Automatic file name

Save Cancel

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-

click the table name.
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i New Databases.odb - OpenOffice Base — O X
Ele Edit View [nsert Tools Window Help X
B-B-E B8 E-0)lBeHe |
[E Create Table in Design View... Description
E Use Wizard to Create Table...
Tables [® create view..
=
E=
Queries
SECOMND " None -
=] SECOMNDTABLE
idjuk SEG_ACSSMODULO
SEG_MODULOS
SEG_USU
Reports SIMPLE_CHAR_TYPES
£ SALE - New Databases2 - OpenOffice Base: Table Data View - O x
Eile Edit View |Insert Tools Window Help
: A Aj I L3
BRI Xm® 0 WS- NBIRT v FY
ROW_ID SALE DATE TERMINAL_ID GROSS_AMT VAT AMT NET_AMT
2 24.12.15 3 11,10 2220 33,30
5 241215 3 11,10 22,20 33,30
T 24.12.15 3 11,10 2220 33,30
E) 24.12.15 3 11,10 22,20 33,30
] 24.12.15 3 11,10 2220 33,30
10 24.12.15 3 11,10 22,20 33,30
1 241215 3 11,10 22,20 33,30
12 24.12.15 3 11,10 22,20 33,30
13 241215 3 11,10 22,20 33,30
14 24.12.15 3 11,10 2220 33,30
15 241215 3 11,10 22,20 33,30
16 24.12.15 3 11,10 2220 33,30
17 24.12.15 3 11,10 22,20 33,30

7. To create an SQL query, click Queries in the Database pane, then click Create Queryin

SQL View...

© 2024 Enter your company name



Using in Third-Party Tools| 103

MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B-@-8 nsE-efie@xe |
- [ Create Query in Design View... Description
15 lﬂ Use Wizard to Create Query... Create a query entering an SOL statement dire
Tables |§‘f|,|. Create Query in SQL View... |

e

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databases.odb Query1 - OpenOffice Base: Query Design = O X
File Edit Wiew [nsert Tools Window Help

E@ @@ "“.Esﬁ.

== WS- NHIRT vI¥|
ROW _ID | SALE_DATE | TERMINALID | GROSS_AMT VAT AMT MET_AMT
NE 24,1215 3 11,10 22,20 33,30 .
s 241215 3 11,10 22,20 33,30
Ik 24,1215 3 11,10 22,20 33,30
L 24,1215 3 11,10 22,20 33,30
I 241215 3 11,10 22,20 33,30
|10 241215 3 11,10 22,20 33,30
In 24,1215 3 11,10 22,20 33,30
|2 24,1215 3 11,10 22,20 33,30
|13 241215 3 11,10 22,20 33,30
4 24,1215 3 11,10 22,20 33,30 |
Record [ [ of 35 ][50 [+ ][] [ ] o o o
SELECT # FROM SALE; #
© 2015-2024
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4.8

Using in PHP

Connecting to Firebird from PHP using ODBC Driver for
Firebird

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Firebird via ODBC. The script connects to
Firebird database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Firebird}

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set
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4.9

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($Recordset, "border=1");

}
odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use
any of them with your PHP projects.
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Using in Power Bl

Importing Firebird Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Firebird, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Firebird and import data into Power Bl Desktop using

an ODBC driver. It is assumed that you have already installed and configured a DSN for

ODBC driver for Firebird.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Firebird

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL

statement.
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5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Firebird data into Power Bl for analysis, select the needed table and click Load.
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410 Usingin Python

Installing the ODBC Driver for Firebird

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Firebird. To use the ODBC driver as

a translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Firebird from Python using ODBC Driver
for Firebird

Here’s an example to show you how to connect to Firebird via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc _ _ _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Firebird};Server=myser
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Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnhxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
print (row)
row = cursor.fetchone()
© 2015-2024
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4.11 Using in QlikView

Connecting to Firebird from QlikView using ODBC Driver
for Firebird

This tutorial describes how to connect and configure QlikView to retrieve data from Firebird
for further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for Firebird, perform the
steps below:
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1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).

@ qlikview %64 Personal Edition - [QV1]

H
=
=

New

Oopen...

Open URL...
Open FTP...

Close

Ctrl+M

i File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

| & | ] % | [ | @ 5 B { K clear ~| @ Back &) Forward | & Lock =5 Unlock

Ctrl+0

Open in Server... Ctrl+Shift+O

Favorites

Save

Save As...

ave LINk

Mail as Attachment...

Viall WIth bOOK!

k

Ctrl+5
F12

Wl Print

Print Sheet...

Source Control

Export

k

| £ Edit Script..

crl+E |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select

the Data Source you created earlier, type in the User ID and Password if your database is

password-protected. You can test the connection by choosing Test Connection. The

Connection Test succeeded message should appear. Click OK to connect to your data

source.
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Q

File Edit Insert Tab

Tools

Help

-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main

v |22 =

3 e

[GET

Data  Functions ‘arables Settings
[ atabaze
| 0DBC v
[ Forze 32 Bit

Connect...

Select...

[1ata from Files —1

[ Relative Paths
[JUzeFTR

@ Connect to Data Source

User ID Pazswond
|m_l,.lid | |ooooo| |

Data Sources

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
Devart ODBLC Driver for bMagento
Devart ODBC Diiver for MailChimp
Diewart ODBC Diriver for MySEIL
Devart ODEC Driver for MetSuite
Dewart ODBC Driver for Oracle
Drewart ODBC Drriver for SOL Azure
Devart ODBC Driver far SOLite
Mesweart CNRC Ciniver for vRacs

[ Show User DSMs

Test Connection...

*

Canecel

Help

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.

Q@ Edit Script [C\Users\Evgeniyl\Documentsynew.qvw®]

File Edit Insert Tab Tools Help
Sl Reload B Debug | [ S| 4 -2 B 2O L3 41 2 Tabs Main x| 25 =
[GET]
ODBC CONNECT TO [Devart ODBC Driver for Firebird]:
SELECT * FROM SALE;|
Data  Functions  Warishles  Settings
Database D ata from Files
| ODBC - BeEsk. [ Relative Paths Table Files...
Uz FTR i Ei
[ Foree 32 Bit Select... BISSE=m Fl=-.
“Web Files...
Field Data...
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Sheet Properties [Main]

General Fields  Objects  Securty Triggers
Awvailable Fields

GROS5_AMT
TERMINAL_ID
WAT_AMT

Add =

Add Al ==

< Remove

*
Fields Displayed in Listboxes
NET_AMT

ROW_ID

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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@ Create Select Statement = O *
Data source Devart ODBC Driver for Firebird Carmmsel,
Database Dirivver....

Cwer Support...

[atabase Tables

Fieldz | Text Order - |

[ Show al REF_GABARITO A ~
Tables REF_TEXTOS GROSE_AMT
S REP_TEXTOS_HIST NET_AMT
ROW_ID
L] Synaryms SECOND SALE_DATE v
[ Spstem Tables | SECOMDTABLE oS
(] Aliases N ¥ | [ Show Icon for Key Fields
Script  Table Columns Preview Blobs
prm— (®) Columin
FROM SALE; () Row
() Shuctured
[] Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.

) QlikView x64 Personal Edition - [CUsersh ODBC\ Documentsh 1.gvw™]

File Edit View Selections

HRN=RoN" =N RE N,

Layout | Settings Bookmarks Reports  Tools  Object  Window  Help

| Add Sheet...

Main
id F
=]

[ I R o R

b ok ok ok ok ek ek
TR b L [ O D

ik

i Promote Sheet
vl Demote Sheet

Remove Sheet

'7g Kl Clear ~ | (& Back (2 Forward | (5 |

Select Fields...
|| | MNew Sheet Object v || [B] List Box...
74 Rearrange Sheet Objects =| Statistics Box...
#Y| Adjust Off-Screen Objects E|l Multi Box...
Align/Distribute v [ Table Box..
all Chart..
E] Input Bozx...
\E] Current Selections Box..,
lil Button...

© 2024 Enter your company name



112

ODBC Driver for Firebird

412

@ clikview x64 Personal Edition - [C\Users\EvgeniyL\Documents\new.qvw*] = O *®
! File Edit View Selections Layout Settings Bookmarks Reports Tools Object  Window Help -0
AR BT = = TRERERI Bea e g MR+ ANEA t_]);@" K clear ~| @ Back @ Forward | (& Lock J"Unlock

Main Sheet

= (R
GROSS_AMT NET_AMT ROW_ID SALE_DATE TERMINAL_ID VAT _AMT
11,10 33,30 2 24.12,.2015 3 22,20
11,10 33,30 5 24.12,.2015 3 22,20
11,10 33,30 7 24.12.2015 3 22,20
11,10 33,30 8 24.12.2015 3 22,20
11,10 33,30 9 24.12.2015 3 22,20
11,10 33,30 10 24.12,.2015 3 22,20
11,10 33,30 11 24.12.2015 3 22,20
11,10 33,30 12 24.12.2015 3 22,20
11,10 33,30 13 24.12.2015 3 22,20
11,10 33,30 14 24.12,.2015 3 22,20
11,10 33,30 15 24.12,.2015 3 22,20
11,10 33,30 16 24.12.2015 3 22,20
11,10 33,30 17 24.12.2015 3 22,20
11,10 33,30 18 24.12,.2015 3 22,20
11,10 33,30 15 24.12,.2015 3 22,20
11,10 33,30 20 24.12.2015 3 22,20
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Firebird as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the

Advanced Settings tab and select ver 2.x from the obec Behavior dropdown.
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Using in Tableau

This section describes how to establish and troubleshoot a connection to Firebird from
Tableau using ODBC Driver for Firebird.

e Using in Tableau

e Troubleshooting in Tableau on macOS
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Using in Tableau

Importing Firebird Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Firebird from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for Firebird. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for Firebird from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Firebird.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.
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Troubleshooting in Tableau on macOS

Troubleshooting ODBC Connection in Tableau on
macOS

The iIODBC driver manager incorrectly handles the SQL_WCHAR and SQL_WVARCHAR
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ODBC data types. To work with these data types in Tableau, create a Tableau Datasource
Customization (. tdc) file in 'Users\[your name]\Documents\My Tableau Repository
\Datasources\' — for example, devart-firebird.tdc, and add the following capabilities to the file:

<?xml version="'1.0"' encoding='utf-8"' 7>

<connection-customization class="'genericodbc' enabled="'true' version="'1.0">
<vendor name='Firebird' />

<driver name='Devart ODBC Driver for Firebird' />
<customizations>

<customization name='CAP_ODBC_BIND_SUPPRESS_WIDE_CHAR' value='yes'
</customizations>

</connection-customization>
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